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1. Inatelephone conversation, a person orders Pizza on the phone. Find out the main elements
in this communication cycle.

« Sender: The person ordering the pizza.

« Message: The order details (pizza type, size, toppings, etc.).

« Channel: Telephone.

« Receiver: The pizza shop employee.

« Feedback: The employee confirming the order.

+ Noise: Any disturbance like a bad phone connection.

« Context: A food order conversation.
2. Give example to all forms of communication.

« Verbal Communication: Talking to a friend.

* Non-Verbal Communication: Smiling at someone.

«  Written Communication: Sending an email.

 Visual Communication: A road sign showing “Stop”.
3. lItis positive feedback (appreciation).

4. "Giving a speech in a public rally” or “A teacher giving a lecture to a large audience” are
examples of public communication.
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1. « Sneha eats pizza.
» The teacher studies a book.
» Twash clothes.
 Rishit drives a car.
» The cook makes a banana.
« The driver swims in water.

* You play with a newspaper.

8 viz Bee

_________
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1. « Direct Object: answers
« Indirect Object: students
2. + Direct Object: a beautiful painting
« Indirect Object: None
3. « Direct Object: pizza
 Indirect Object: None
4. < Direct Object: a poem
 Indirect Object: None
5. « Direct Object: a new dress

« Indirect Object: his daughter

8 Unsolved

Section A (Objective Type Questions)

A. 1. c 2. a. 3. ¢ 4. c. 5. b. 6. C. 7. b.
8. a. 9. ¢ 10. b. 11. a. 12. d.
B. 1. Communication 2. receiver 3. Non-verbal 4. Communication skills
P
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5. Decoding 6. Feedback 7. communication 8. Constructive
9. General 10. linguistic

C. 1. False 2. True 3. False 4. True 5. False
6. True 7. True 8. True 9. False 10. False

Section B (Subjective Type Questions)

A. 1. Verbal communication is the most popular form of communication where the transmission of
messages occurs with the usage of words that can be in oral spoken or written form. It includes
sounds, words, and speech. It is often used during presentations, video or teleconferences,
informal or formal telephone calls, discussions, lectures, public speaking, meetings, etc.

2. a. Think about your topic.
b. Think about the most effective ways to make your listeners understand the topic.
¢. Write or note down whatever you plan to say.

3. Feedback is a response of the receiver with respect to the message received from the
sender. It works as an indicator for the successful transmission of the message thus making
communication a two-way process.

Examples:
« "Nice work done by you.”

+ "You were really good on stage but if you work more on your voice modulation, then you
can do wonders.”

4. Positive feedback focuses on the sender’s strengths, achievements or successes. It also takes
care of the areas of improvement and creates a positive attitude for the sender.

For example:
« “Nice work done by you.”

* "You were really good on stage but if you work more on your voice modulation, then you
can do wonders."

Negative feedback highlights the weaknesses and problems of the information that the
sender has conveyed to the receiver. It should be genuine or true to bring a positive change
in the process of communication.

For example:

* "You did not submit your assignment.”
* "You wrote your answers very badly.”

+ Taking long time to reply email, SMS.
« Not smiling at the time of meeting.

5. Culture is values and principles followed in the lives of people living in society. It is the sharing
of customs, rituals, beliefs, ideas, art, knowledge, values, morals, ideals, etc. amongst people
living in their own geographically restricted areas.
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6. When the subject in the sentence has performed or received the action it becomes the
voice of a verb in the sentence. In an active sentence the action is performed by the subject.
It is a strong and direct way of expressing a sentence.

For example: Shweta is eating chocolate.

7. Article is a word that describes the noun. It is used before a noun to show whether it is
specific or not. In English grammar there are three articles—A, An, The.

8. Direct Objects: Direct objects come after a verb and are directly ‘acted on’ by the verb. It
answers the question “what?” or "who?".

For example: She sang on Annual day. Peter doesn't like Maths.

Indirect Objects: Indirect object is the recipient of the direct object. It answers the question
“to whom?”, “for whom?”.

For example: She made a cake for her mother’s birthday. He wrote a letter to his friend.

9. Collection of relevant and meaningful words following the rules of a language will form
a sentence. Every word you use in a sentence has its own role to play. Every word has a
specific function to play in a sentence to make it meaningful. It falls into different categories
to play a different role in a sentence. These categories are called the Parts of Speech. It
is important to learn these different parts of speech to understand the language well to
help you construct good sentences for effective communication.

10. Noun is a word to name a person, place, thing or an idea.
For example: Goa is a beautiful place. My pen is broken.

Pronoun is a word that replaces a noun. They are used to avoid the repetition of nouns
so that the sentences are smoother and effective.

For example: Words are: , she, her, you, himself, some, we, you, each, who, which, that,
mine, yours, his, her

1. Sender: Sender is a person or entity who starts the communication process. He will convey
a message with the purpose of passing meaningful information/ideas to others involved
in the communication cycle.

Message: It is the information which the sender wishes to convey to the receiver. It is the
subject with the actual content of the whole process of communication.

2. Cultural Barrier:

Culture is values and principles followed in the lives of people living in society. It is the
sharing of customs, rituals, beliefs, ideas, art, knowledge, values, morals, ideals, etc. amongst
people living in their own geographically restricted areas.

« As the mindset of people of different cultures are different, so is their language, signs
and symbols. This causes a barrier to communication.
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« Culture also gives rise to prejudices and stereotypes. These become the societal norms,
thus becoming a barrier to effective communication amongst people of different cultures.

 Different cultures adopt different ways of communication. For example, some cultures
may be very open while others may be orthodox, thus affecting ways people communicate
among various cultural sects. For example, in Arab countries it is considered to be a
social crime to greet an opposite gender by shaking hands.

Linguistic Barrier:

The inability to communicate using a language is known as a language barrier to
communication. This inability may be due to lack of common language, inefficiency to use
the language since it is not a mother tongue or speaking disability.

« An English person traveling to Japan will not be able to interact with Japanese people
if he doesn’t know Japanese.

« Sometimes, people belonging to different places may be speaking the same language
but have different pronunciation, dialect, meaning and interpretation which may lead
to miscommunication, thus altering the overall process of communication.

« Sometimes, a specific organisation or industry uses certain technical words or symbolic
words or jargons and slangs which make it easy to communicate. If a new employee
joins or is transferred to a new environment, then the efficiency of the whole process
may reduce due to lack of knowledge of these words.

« Some people may have language disabilities such as stuttering, dysphonia or hearing
loss while others working with these people in an organisation may be spontaneous
and grasp things easily which creates a lot of difficulty in communication.

3. « Clear: The message intended to be delivered through communication should be clear
and in understandable format. Clarity in writing or speaking of the message plays a
very important role in effective communication.

« Concise: The message must be conveyed by using only limited words. Avoid using fancy,
unwanted or repetitive words or fillers otherwise the actual message intended to be
conveyed may get lost in the long content.

+ Concrete: The content of the message should use only necessary words with complete
facts and figures to avoid misinterpretation of the message by the receiver.

4. The process of giving a feedback should follow the given steps:
Step 1: The message should be clear, and interpreted properly by the receiver.
Step 2: If the message is not clear, then clarify from the sender by asking questions.
Step 3: Always refers to the original form of message to understand it clearly.

Step 4: Convey the response in the form of feedback to the sender.
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5. Inadequate flow of information amongst employees working at different levels of hierarchy
may lead to organisational barriers.

This may be due to:

« The restricted rules and policies of an organisation as the employees avoid getting
into the hassle of sending or receiving any message. For example, if the company rule
says that all communication should be in writing, then even a small message where
time constraint plays a very important role in decision making may lead to delay in the
transmission due to writing formalities and level of approval required from different
people.

+ A formal communication protocol is always followed when communication takes place
between a senior and his subordinate. In such situations, a subordinate employee will
always have fear, anxiety and withdrawal in communication.

6. Eye Contact:

Keeping a proper eye contact shows you are mentally present and actively involved in
communication. The way you look at someone will reflect some of the strongest emotions
and feelings during a social conversation. Rolling your eyes expresses displeasure or
unhappiness with a situation.

Eye contact helps you:

 Facilitate the connection with your audience in a meeting, conference, presentation,
etc.

« Improve your concentration

« Give confidence and authority

 Retain the important points of conversation

« Express your emotions like sadness, happiness, surprise, fear, etc.
Body Posture:

Body posture is the position of the human body and its alignment and orientation with
respect to non-verbal communication. During a conversation, the way you sit or stand and
communicate your body postures to others depends a lot on your attitude and emotional
state. Before you start a conversation, standing straight and holding your head high will
have a great impact on the crowd.

The correct body postures for effective non-verbal communication are:
« Keep your shoulders straight and body relaxed
« Sit straight while resting your hands and feet in a relaxed position

« While standing, keep your hands by your sides
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Appearance:

Appearance includes our choice of colour, body cleanliness, properly dressed, hairstyles,
etc. When you are speaking in public, you may be representing your organisation or just
yourself. You should ensure that you are properly and neatly dressed. It also increases
your self-confidence and you will definitely feel good about yourself.

7. Visual Communication is the transmission and interpretation of information by using visual
resources like photographs, videos, art, drawings, sketches, charts and graphs. Visuals
enhance the process of communication during written or verbal communication for better
understanding and a meaningful interpretation of the information. It has a great impact
on our day-to-day life.

For example, traffic signals for stop, wait or go. To indicate ‘danger’ we use a red colour
sign, to indicate 'no smoking’ we use an image showing a lighted cigarette with a cross
mark on it, etc.

Some of the common examples of visual communication in our day-to-day lives are:

Horn Prohibited No Parking

Ladies and Gents Toilet No Left Turn

Pedestrian Crossing

8. a. « Encoding: It is the process of converting the message into a form in which only the
intended receiver can understand by converting the actual message into symbols,
words, actions, and diagrams.

+ Decoding: It is the interpretation of the message delivered by the sender.
b. Verbal:

Verbal communication is the most popular form of communication where the
transmission of messages occurs with the usage of words that can be in oral spoken or
written form. It includes sounds, words, and speech. It is often used during presentations,
video or teleconferences, informal or formal telephone calls, discussions, lectures, public
speaking, meetings, etc.

8.0
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Verbal Communication can be divided further as:

« Oral or Spoken Communication: Communication which involves speaking. It can be
face-to-face conversation or talking on a phone.

« Written Communication: Communication which involves written or typed words. It
can be writing letters, notes, email, etc.

Non-Verbal Communication:

Non-verbal communication is defined as communication through physical and physiological
cues without using spoken or written words. The information is transmitted using body
language, touch, facial expressions, symbols, signals, etc. Most of our communication with
the people around us throughout the day is non-verbal and most of the time we are not
aware of it. It is helpful when trying to understand others’ thoughts and feelings.

Non-Verbal communication can be further classified into: Facial Expressions, Body Language
and Gestures, Eye Contact, Body Posture, Appearance, Personal Space and Proximity,
Paralanguage, and Haptics.
9. a. Verbal communication
Advantages
« The information conveyed can be saved for future use by recording the verbal or
written communication.
« The exchange of ideas and thoughts are straightforward, quick and saves a lot of time.
Disadvantages

« Lengthy messages (written or oral) are difficult to comprehend, unsuitable, and boring
especially in a crowd.

« As messages are delivered instantly, there is no scope for rectification of wrong words
used in oral or written messages.
b. Non-Verbal communication
Advantages
« It is used as complimentary with verbal communication to enhance the effect of

communication.

 Itis a useful, fast and easy method of communication where no common language
is required to master.

Disadvantages

 Since it uses gestures, facial expressions, eye contact, touch, signs, sound, etc. for
communication, there are chances of misinterpretation of the message required to
be delivered.

 Itis not suitable for long and lengthy messages as the actual message may get lost
in a lengthy and time consuming conversation.
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c. Visual communication
Advantages

« When the content is lengthy and difficult to explain, then it can be easily handled
through visuals in a shorter period of time.

« There is no prerequisite of learning a specific language and can be used by people
in different geographical areas with different cultures.

Disadvantages

It is a time-consuming process as designing and decorating takes more time than
writing or conveying orally.

+ Visuals alone are not a complete way of delivering meaningful information. It needs
other forms like verbal and non-verbal to complete its communication.

10. A sentence is made up of:
« Subject: A subject is a noun that refers to a person, place or thing.
« Verb: It is the action done by the subject.
« Object: It is a person, place or thing that receives an action and gets affected.
For example:
He drove a brand new car.
Subject: He Verb: drove Object: new car

My mother cooks wonderful food. Subject: My mother Verb: cooks Object: wonderful food
I love ice cream.

Subject: I Verb: love Object: ice cream

11. A paragraph is a collection of relevant sentences with a common theme. It begins with
an introduction of a theme, followed by sentences describing a theme and ends with a
statement supporting a common idea.

For example: Water is an essential component of our life. With its scarcity all across the
world it is becoming a threat to the existence of life on earth. With rising levels of pollution,
water resources are being depleted rapidly. The entire Earth consists of 71% water, out
of which only a small percentage is drinkable freshwater. It is therefore very essential to
save water, to save lives.

Some general rules for writing a paragraph are:
+ It begins on a new line.
+ The first line has an indentation.

« It focuses on a main theme.
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1. « Physical Barrier: Physical barriers arise due to environmental or geographical factors that
hinder effective communication. Some possible reasons for Rakesh’'s communication
challenges include:

« Noise disturbances: Traffic sounds, classroom noise, or background music might prevent
him from clearly hearing instructions.

« Uncomfortable environment: Extreme temperatures in the classroom may cause
discomfort and reduce concentration.

« Technical issues: If digital tools are used in the class, poor internet connectivity or
malfunctioning devices may affect understanding.

+ Classroom infrastructure: Poor seating arrangements, inadequate lighting, or faulty
audio systems can create distractions and hinder communication.

These physical barriers may prevent Rakesh from fully grasping what is being
communicated, leading to difficulties in following instructions.

2. « Effective communication methods for Rahul: Use positive reinforcement: Encourage his
brother by appreciating his efforts before pointing out mistakes.

+ Be patient and clear: Explain corrections in a simple and understandable way.

« Use active listening: Ask his brother for feedback to ensure he understands and values
the guidance.

+ Choose the right tone: Speak in a friendly and supportive manner rather than sounding critical.

Provide examples: Show correct answers through real-life examples or relatable
explanations.

3. « Berelaxed, calm and confident when you walk-in for starting a communication.
+ Keep smiling in between as it shows that the person is confident and trustworthy.
+ Stand or sit with a relaxed posture and straight spine.
+ Keep your arms open and by your side when not communicating.
« Do hand shake, bow or namaste before you begin with the conversation.
« Make eye contact occasionally to show your level of involvement.
« Be a good listener and nod in between while listening.
« A little movement is necessary if you are giving a presentation.

 Place your feet firmly on the ground while moving during your presentation or addressing
a gathering.

« Give a positive facial expression and try to be natural with your gestures.
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Previous Years' Questions

1. c

2. Cultural differences can hinder communication when variations in language, nonverbal cues,
norms, and values lead to misunderstandings. These differences may cause the sender’s
intended message to be misinterpreted by the receiver.

b.
d.

Phrases

o oA W

« Declarative Sentence: Makes a statement (e.g., “The sky is blue.”).
 Interrogative Sentence: Asks a question (e.g., “Is the sky blue?”).

« Imperative Sentence: Gives a command or request (e.g., “Look at the sky.").

« Exclamatory Sentence: Expresses strong emotion (e.g., “What a beautiful sky!”).
7. ourselves

8. spacious

9. Prepositions are words that show the relationship between a noun (or pronoun) and other
words in a sentence. Examples include: on, under.

10. b.
1. b.
12. a.
13. d.

14. The workshop was informative and engaging. It covered essential topics such as online
safety, protecting personal information, and preventing cyber threats, leaving participants
better prepared to navigate the digital world.

@ DL, .
GROUP DISCUSSION @@@?

Do it yourself.

52 Page-51

] Video based question Page-51

Do it yourself.

—Page—52

Do it yourself.

CLASS ACTIVITYQ
-Page-52

Do it yourself.
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m Self-Management Skills-II

find s Google . o 54

Do it yourself.
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1. » Lack of sleep * Restlessness and anxiety
« Frequent headaches « Frequent mood swings
+ Loss of appetite * Loss of interest and focus
* Memory loss « Social withdrawal or isolation

2. Stress can be defined as our emotional, mental, physical and social reaction, to any perceived
demands, or threats.

3. Whether you are facing good stress or bad stress, it is important to learn some stress
management techniques to minimize the negative impact on mind and body.

_________

{__/ iPage-58

........

1. a. Time Management
b. Physical Exercise and Fresh Air

2. The practice of yoga involves stretching the body and forming different poses while keeping
your breathing slow, and controlled. This will relax the body and energise it at the same time.

_________

{_/ iPage-59

1. Agood sleep helps you manage the stress of a tough day. It rejuvenates the mind and body,
improves your concentration power, regulates your mood swings and sharpens your brain
for better decision-making power. Sleep is so important that irregular sleeping patterns or
slight sleep deprivation can bring irritation in your behaviour, and cause severe mood swings.
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2. Meditation is an age-old practice that produces a deep state of relaxation and helps you focus
on one thought and clear the others. It works to reverse the effects of stress by providing
rejuvenation and repair of the mind and body. Thus, preventing further damage from the
physical effects of stress.

3. Advantages:
 Increased Focus
+ Making Progress on Assignments
» Working at Your Own Pace
« Can Work Remotely

» Better Job Satisfaction

8 viz Bee

_________ h
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________

1. My top four strengths are hard work, creativity, problem-solving, and teamwork.

2. Tuse my interestin learning and my abilities to stay focused, complete assignments on time,
participate in class activities, and help my friends understand difficult topics.

3. Mention your one strength which you used recently to get good grades in your project.
Ans. Creativity helped me recently in my project, as I used innovative ideas to present my
work, making it more engaging and well-organized, which helped me get good grades.

8 Unsolved
Section A (Objective Type Questions)

A. 1. c 2. b. 3. d 4. c 5. b.

B. 1. Stress 2. eustress 3. financial stress 4. Exercises 5. negative
6. value, priorities 7. Confidence, self-discipline, and determination
8. Time management skills

C. 1. True 2. True 3. False 4. True 5. True 6. True 7. False
8. True 9. False 10. True

Section B (Subjective Type Questions)

A. 1. Goalsetting is the process of identifying your dreams and then planning and implementing
your methods, and strategies to fulfil them. Goal settings provide you with a target and help
you focus on what's really important to you, which will make you successful in your career
and personal life.

8.0
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2. Stress Management is a method or a technique used to make changes in your lifestyle,
thoughts, and emotions that help you relax your mind, and body to minimize the effects of
stress.

3. The practice of yoga involves stretching the body and forming different poses while keeping
your breathing slow, and controlled. This will relax the body and energise it at the same time.

4. Symptoms:
« Lack of sleep
« Restlessness and anxiety
« Frequent headaches
+ Frequent mood swings
« Loss of appetite
5. Advantages:
« Manage your energy levels.
« Understand your emotions and behaviour.
 Balance your thoughts and emotions.
« Understand your long term goals.
+ React in a positive way in difficult circumstances.
« To be happier by controlling your emotions.

1. Good stress, also known as “Eustress”, occurs when we are excited. Our heart beat faster, and
we feel a rush of hormones in our body, but it is not dangerous for us. We also feel this good
stress before a public performance, ride in water parks, or when the exam result is declared.
This kind of stress keeps us lively and excited in life. So in the short term, stress can have a
positive impact on us, and our behaviour. Eustress motivates us to achieve more, but when
the duration of stress increases for a long time then, it takes the shape of bad stress, which
may cause physical or mental health problems. Exam stress, for instance, is beneficial to you
since it helps you stay alert and study for the test; however, chronic stress can lead to health
problems such as headaches, nausea, and fainting during the test. Thus, stress management
is crucial to success in life.

2. Time Management When you feel that there is too much to do and not enough time
then, you start getting panic attacks, lose focus and make errors in your work. Good Time
Management techniques will help you prioritise your task and manage your commitments.
Make a list of the work in terms of urgent, important, and not important. This will put
you in control of your situation and help you increase your productivity. In academic life,
keeping your notes organised, finishing assignments on time, and tracking deadlines can
help reduce stress.
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Interests

Abilities

Things that you like to do in your free time
that make you happy.

An acquired, or natural capacity.

Things you are curious about, or would do
even if no one asked you to do it.

Enable you to perform a particular job or task
with considerable proficiency.

Things you want to learn or would like to do
in the future.

Skills that you have developed, or are
developing, that make you proficient in
certain tasks.

Example: Curiosity to learn a musical
instrument, desire to travel, and explore
new cultures.

Example: Mastery in playing the guitar, ability
to navigate and adapt to different cultural
environments.

4. Time Management is the ability to utilise your time effectively so that you are able to do
the required task at an appropriate time. It helps you focus better on important tasks, which
leads to better efficiency. It gives you a feel that you are never running out of time.

 Plan your activities to avoid any delay or postponement of assigned tasks.

« Organise your work. Keep your desk clean. Put everything in place at home, and in school.
Put the books back on the shelves.

« Find a place with minimum disturbance so that you are able to complete your assigned
tasks.

« Make a reasonable 'To-do’ list.

« Prioritise your task based on its importance.

« Spend your time efficiently.

« Look for activities that save you from wasting time on insignificant activities.

5. Keeping track of your daily time helps you stay focused and avoid wasting time on unnecessary
activities. By noting how you spend each hour, you can see which tasks are important and
which ones take up time without adding value. This habit allows you to manage your time
better, stay productive, and work towards your short-term and long-term goals. At the end
of the day, you can review your progress and make improvements.

Neha should highlight skills such as goal setting, time management, positive thinking, self-
discipline, and resilience. Encouraging students to stay focused, break tasks into smaller steps,
and reward themselves for progress can help them stay self-motivated and take charge of
their learning.

2. It is important to judge yourself based on your own views and performance rather than
others’ expectations. Setting personal goals and evaluating progress based on your own
efforts helps build confidence and self-worth.

8.0
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3. To help Sohan manage exam stress, I would suggest techniques like deep breathing exercises,
regular breaks while studying, maintaining a balanced diet, getting enough sleep, and
practicing positive affirmations. Encouraging him to stay organized and revise with a clear
plan can also reduce anxiety.

Previous Years' Questions

1. b.

2. d.

3. Time management skills help individuals prioritize tasks, reduce stress, increase productivity,
and achieve goals efficiently, leading to overall success in personal and professional life.

4. c.

5. b.

6. d.

7. » Reduces anxiety and improves overall mental health.

« Enhances focus and productivity in daily tasks.

8. * Yoga is a physical practice that includes postures and breathing exercises to enhance

flexibility and strength.

« Meditation is a mental exercise focused on mindfulness and relaxation to achieve inner
peace.

9. b.

10. b.

1. c

12. Self-awareness is the ability to recognize and understand one’s own emotions, thoughts,

and behaviors.

Benefits:

« Helps in making better decisions.

« Improves relationships by understanding personal strengths and weaknesses.

13. (a) Mental Stress Causal Agent: Academic Pressure: The stress of needing to perform well
in exams and assignments, constantly worrying about grades, and the pressure to meet
academic expectations.

(b) Social Stress Causal Agent: Peer Pressure: Feeling the need to conform to the behavior,
attitudes, or lifestyle choices of a peer group, which can lead to anxiety or stress, especially
when one’s values or preferences differ from those of the group.

14. b.

|
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15. Stress management

16. Self-awareness

17. « Past experiences and failures.
« Support from family and friends.

18. Productivity and efficiency

19. « Choose a destination that everyone agrees on.
« Plan transportation and accommodations in advance.
 Carry necessary essentials like food, water, and first-aid.

+ Capture memories with photos and enjoy the experience fully.

& Video based question Page-71

Do it yourself.

LAB ACTIVITY
Page-71

Do it yourself.

CLASS ACTIVITYG
Page-71

Do it yourself.

Information & Communication Technology

R sicilts-1n

__________

{__/ tPage-83

1. The Notification Area is a small part of the taskbar in Windows that shows system icons,
time, battery, volume, and app notifications.

2. Windows 11 has several components, including the Start Menu, Taskbar, File Explorer,
Notification Area, and Settings.

3. Data is stored in the form of files and folders on a computer, which can be documents,
images, videos, or software programs.
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8 Unsolved
Section A (Objective Type Questions)

1. a. 2. b. 3. b 4. c 5. d. 6. a.

1. file 2. name, extension 3. Shortcut 4. folder

5. Virus 6. Computer maintenance 7. Backup 8. Disk cleanup
1. True 2. False 3. False 4. True 5. True 6. True

Section B (Subjective Type Questions)
1. Mobile operating systems have Graphical User Interface with menus and buttons supporting
different types of apps on Smartphones, tablets, smart watches or other portable devices.
It is a combination of an operating system and communication technology.

2. + File: Any data in the computer is stored in the form of a file.
« Folder: Folder is a collection of related files and subfolders.

3. Utility software does housekeeping functions like backing up disk or scanning/cleaning
viruses or arranging information etc. They ensure the smooth functioning of the computer.

4. Steps to Delete Temporary Files on Your Computer:

« Press Windows + R to open the Run dialog box.

« Type %temp% and press Enter.

+ A folder with temporary files will open.

e Press Ctrl + A to select all files.

 Press Delete on your keyboard and confirm.

« Empty the Recycle Bin to remove them completely.

5. ¢ Use a soft cloth: Wipe dust from the monitor, keyboard, and CPU.
« Use compressed air: Clean inside the CPU and keyboard to remove dirt.
« Keep devices in a dry place: Avoid moisture to prevent damage.

6. Data backup is important because it protects important files from being lost due to system
crashes, viruses, or accidental deletion. It helps in recovering data when needed.

1. Computer virus is a malicious code that attaches itself to a file and enters your computer
system and makes copies of itself and carries out the harmful tasks in such a way that it
damages the important files of an operating system or application programs or important
data files due to which the computer may stop working.

Major types of viruses are Worms and Trojan Horse.

«  Worms: Computer worms are a type of malicious software or malware that can replicate
and spread on their own mainly across computer networks.

« Trojan Horse: This malicious software disguises itself as a useful software but is designed
to carry out harmful activities on a computer. The name “Trojan Horse” comes from the
ancient Greek story of the wooden horse used to infiltrate the city of Troy.

fiol

g Trackpad IT402-X (Ver. 1.0) (Answer Key) :<<<<<<<<<<<<<



2. « Avoid clicking on unknown clicks available in between your internet browsing.
« Do not reply to spam messages.
» Download spam filtering tools and anti-virus software.

« Do not use your personal or business email address when registering in any online contest
or free services available on the internet.

3. Security break refers to the unauthorised access of sensitive information stored in a computer.
Personal information can be lost or leaked in two ways:

« We are not careful in giving out personal information over the Internet. For example, we
share our account details and passwords on unsecure sites.

« A person gets unauthorized access to our computer. This can happen in the office if we
leave the computer without logging out.

C. 1. Neha should follow these steps to remove the virus:
« Run a full system scan using a trusted antivirus software.
+ Delete or quarantine the infected files as suggested by the antivirus.
« Update the antivirus and operating system to prevent future attacks.
« Avoid downloading files from unknown sources.
2. Niharika pressed too hard, which may have damaged the screen. She should have:
+ Used a soft microfiber cloth to gently wipe the screen.
« Avoid using too much pressure or rough materials.

+ Used a screen-safe cleaning solution instead of spraying liquid directly on the screen.

Previous Years' Questions
1. b.

2. Spam mails are unwanted, unsolicited messages sent in bulk, often for advertising or
fraudulent purposes. These emails should be deleted immediately, marked as spam, or
reported to prevent future spam messages.

3. b.
4. c.
« Afileis a collection of data stored on a computer with a specific format (e.g., document,
image, or video).
« Afolderis avirtual container used to organize multiple files and subfolders on a computer.
C.
a.

=
©

>>>>>>>>>>>>> Trackpad IT 402-X (Ver. 1.0) (Answer Key) ‘1?2;
/ &



8. Online threats:
+ Phishing (fake emails or websites that steal personal information).
« Malware (harmful software like viruses or spyware).
Safety measures:
« Do not click on unknown links or download suspicious attachments.
« Use strong passwords and update them regularly.
« Install and update antivirus software on the computer.
9. a

10. a. Firewall: A security system that monitors and controls incoming and outgoing network
traffic to protect against cyber threats.

b. SPAM: Unwanted, bulk emails that often contain advertisements or fraudulent messages.

LAB ACTIVITY
~/ Page-99

Do it yourself.

CLASS ACTIVITYQ
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Do it yourself.

m Entrepreneurial Skills-II

Find on Google

Do it yourself.
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1. Kavita thought only unique ideas succeed, but many businesses grow with simple yet well-
executed concepts.

2. Aman believed large funding was necessary, but many entrepreneurs start small and grow
gradually.

3. Meera assumed entrepreneurship is only for big companies, but even small online stores are
part of entrepreneurship.
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4. Radha is thinking that lack of funds is a complete barrier to starting a business but many
successful businesses started with limited resources but grew through smart planning and
hard work.

8 Unsolved

Section A (Objective Type Questions)
. b. 2. d. 3. c 4. d. 5. d.
. opportunity recognition, idea development, business startup

. Change

1

1

2

3. career
4. Entrepreneurship

5. Innovation

1. True 2. True 3. False 4. False 5. False

Section B (Subjective Type Questions)
A. 1. Apersevering person does not give up easily and keeps trying even when things are difficult.

2. Anyone with a good idea, willingness to take risks, and the ability to work hard can become
an entrepreneur.

3. < Creates jobs for people
» Helps the economy grow
+ Brings new and useful products or services
4. + You need a lot of money to start a business
« You must have a unique idea to succeed
« Entrepreneurs don't fail
5. A misconception is a wrong belief, while reality is the truth.

Example: Misconception — “Entrepreneurs don't take risks.” Reality — "Entrepreneurs take
smart risks to succeed.”

B. 1. Entrepreneurs manage their business operations, making strategic decisions to drive growth
and profitability. They also innovate, adapt to market changes, and solve problems to meet
customer needs and demands.

Some of the actions of entrepreneurs are listed below:

« Fulfil Customer Needs: Demand means a product or service that people want. Entrepreneurs
find out what people want. Then, they use their creativity to come up with a business idea
that will fulfil the changing demands of the customers.

&R
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+ Use Local Materials: Entrepreneurs utilise available materials and people around them in
innovative ways, combined with new technology, to create new products at a reasonable
cost.

+ Help Society: Entrepreneurs foster a beneficial relationship with society by generating
profits through activities that enhance societal well-being. Some entrepreneurs focus
on environmental conservation, while others contribute funds for building schools and
hospitals, thereby improving the communities in which they live.

» Develop the Country: With the success of an entrepreneur the people connected to it all
share the success and thus helps in the overall development of the country.

2. Inorderto become successful, an entrepreneur needs to perform different roles. The following
are the roles of an entrepreneur:

« Innovator’'s Role: An entrepreneurship is about new and creative ideas converted into a
real world of business which is beneficial both for the entrepreneur in making profits and
for the customer in getting a new product in the market. All those once was just an idea
but only entrepreneurs brought those ideas to life.

« Agent's Role: Entrepreneurs are considered as ‘Agents of Change'. They look for
opportunities that help in converting their dream or passion into reality by initiating and
creating a business and converting all the challenges faced into a new successful product.
This product creates a new market and helps in raising the standards of the community
and contribute to the overall development of the economy.

+ Risk Assumption Role: An entrepreneur assumes all possible risks of business rising
from unstable market conditions, change in the customers preferences, new emerging
technologies in the production, change in environmental factors, and fluctuations in the
profits.

« Capital Formation Role: Setting up an enterprise needs investment. This investment can
be taken from personal savings, loans, shares etc. The money is utilised in the capital
formation like developing infrastructure in the nearby area, developing the network and
transport facilities. All these efforts help in the company trade and capital formation of
the country.

« Employment Generation Role: Entrepreneurs generate employment for both skilled and
unskilled labourers by setting up large and small-scale businesses. This leads to the
reduction in unemployment levels in the country.

3. Entrepreneurship offers several advantages that attract individuals to start and grow their
own businesses:

* Flexibility and Independence: Entrepreneurs have the freedom to set their own schedules,
make decisions autonomously, and pursue creative ideas without the constraints of
traditional employment.

« High Rewards: Successful entrepreneurs have the potential to earn substantial profits and
build wealth through their ventures. They can also benefit from the scalability of their
business ideas.

fio)
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Job Creation: Entrepreneurship stimulates job creation and economic growth by hiring
employees, subcontractors, and suppliers, thereby contributing to the community and
economy.

Personal Growth: Entrepreneurship provides opportunities for personal development and
learning. Entrepreneurs continually face challenges that help them develop resilience,
critical thinking skills, and leadership qualities.

Entrepreneurship, while rewarding, also comes with its own set of challenges and
disadvantages:

Financial Uncertainty: They often face financial instability, especially in the initial stages
of their venture. Cash flow problems, difficulty securing funding, and the risk of personal
financial loss can be significant stressors.

Long Working Hours: Entrepreneurs typically work long hours, including evenings and
weekends, to build and sustain their businesses. This can lead to burnout and strain
personal relationships.

Risk of Failure: The failure rate for startups and new businesses is high. Many ventures
fail due to market changes, competition, or unforeseen challenges.

Increased Responsibility: Entrepreneurs often bear ultimate responsibility for the success
or failure of their ventures. This includes managing employees, satisfying customers,
managing legal and regulatory issues, and more.

. Optimistic: Entrepreneurs take risks in terms of time and money. They put their dreams

into action so they need to be optimistic to see the success of their dreams. Optimistic
people tend to be more creative in their thinking. It stimulates all kinds of creative ideas
which will lead to new products, services, or businesses having a greater chance of success.
Sometimes, they even face so many problems and setbacks but still won't give up.

Independent: An entrepreneur is someone who establishes new ventures through their
own innovative ideas. They thrive on working independently, making critical decisions for
their venture. They take full responsibility for the outcomes of their independent decisions.
Freedom to work and take ownership is often cited as a key advantage in successfully
running their own business.

5. Acareeris aline of work that a person takes for life. A person who becomes an entrepreneur
goes through a career process.

This process is as follows:

Enter: It means implementing an idea by starting a business and entering a new market.
For example, Amit is starting a small stationery store in his locality.

Survive: It means to remain in the competitive market in between other entrepreneurs
dealing with the same business. For example, there are many other stationery stores in
the area. Despite this, Amit is surviving the competition and doing well. He even bought
the next-door shop and expanded his small store to a big fancy stationery outlet.

Grow: It means after attaining a reputation and stability, an entrepreneur plans to expand
the existing business. For example, after a few years, Amit has opened a chain of three

8.0

DI2XI0000) Tackgad 1402 e 10 e ) 23,



more stationery stores in the same city. He even plans to expand it to other neighboring
cities as a new brand.

1. To be a successful entrepreneur, I should have qualities like creativity, problem-solving
skills, leadership, risk-taking ability, and determination. My action plan includes identifying a
business idea, researching the market, making a budget, and planning marketing strategies.
The name of my company will be “InnoTech Solutions,” with a modern and innovative logo.
The slogan will be “Innovate, Elevate, Succeed!”

Collect one success story of a well-established entrepreneur you have known till date. Try
to get some pictures and make a project on it by collecting some facts and figures.

2. Oneinspiring success story is of Elon Musk, the founder of Tesla and SpaceX. He started with
PayPal and later launched innovative companies that changed the automobile and space
industries. His vision and risk-taking ability made him a global entrepreneur. I will collect
pictures, facts, and figures about his achievements and create a project on his journey.

3. Twill explain to my cousin that taking calculated risks is essential for success. Many famous
entrepreneurs like Steve Jobs and Jeff Bezos took risks to build their businesses. I will
encourage him to start small, plan wisely, and not fear failure because failures teach valuable
lessons. If he is passionate and hardworking, he can turn his dream into reality.

4. Twill advise Vedika to start her business as a side project while working a job for financial
stability. She can save money and explore funding options like investors, business loans, or
crowdfunding. If her start-up starts growing, she can leave the job and focus full-time. This
way, she won't take a huge risk but can still follow her dreams.

Previous Years' Questions

2. « Entrepreneurs are born, not made: Reality: Entrepreneurial skills can be learned and
developed through experience, education, and practice.

+ Entrepreneurs always take high risks: Reality: Successful entrepreneurs take calculated
risks and make well-researched decisions.

3. Myth. Anyone can develop entrepreneurial skills through learning, experience, and
determination.

4. b.

5. « Innovative thinking: Ability to come up with new ideas and solutions.
+ Risk-taking ability: Willingness to take calculated risks to grow their business.

6. * Advertising and marketing: Promoting products or services to reach potential customers.
+ Publicrelations: Building a positive image of the business through media and networking.

7. Entrepreneur
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8. Leadership

9. True.

10. » Innovation: Developing new ideas, products, or services.
 Risk-taking: Making strategic decisions despite uncertainty.
* Proactiveness: Identifying opportunities before competitors.

 Persistence: Overcoming challenges and failures to achieve success.

GROUP DISCUSSION JGif

Do it yourself.

Page-120

% Video based question Page-120

Do it yourself.

LAB ACTIVITY 120
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Do it yourself.

CLASS ACTIVITYG
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Do it yourself.

m Green Skills-1I

tind on Google 5, 126

Do it yourself.
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1. Goal 4 aims to ensure inclusive and quality education for all and promote lifelong learning
opportunities.

2. There are several major problems, including climate change, pollution, poverty, deforestation,
and resource depletion.

3. « Climate change: Rising global temperatures and extreme weather affect ecosystems and
human life.
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« Resource depletion: Overuse of natural resources leads to scarcity and environmental
degradation.

Sustainable development ensures a balance between economic growth, environmental
protection, and social well-being, securing a better future for the next generations.
8 Unsolved
Section A (Objective Type Questions)

a. 2. d. 3. d 4. c 5. d.

Sustainable development

Solar energy

NITI Aayog

6 (Clean Water and Sanitation)

Organic

C. 2. e. 3. d 4. b. 5. a.

. True 2. True 3. False 4. False 5. True
Section B (Subjective Type Questions)

(i) No Poverty

(i) Zero Hunger

(iii) Quality Education

(iv) Climate Action

(v) Clean Water and Sanitation

(i) Lack of funding and financial resources

(i) Climate change and environmental degradation

(i) Protects natural resources for future generations

(i) Improves economic growth and stability

(iii) Reduces pollution and environmental damage

The aim is to eradicate poverty, ensure environmental sustainability, promote economic
growth, and improve the overall well-being of people worldwide by 2030.

It teaches us to use resources efficiently, avoid wastage, and ensure they are preserved for
future generations.

The specialised skills which are important for building or developing a Sustainable Green
Economy are called Green Skills. Learning green skills is one of the major ways to enhance
knowledge, abilities, values, and attitudes to develop and support organisations that focus
on improving environmental conditions. The Government of India launched the Green
Trackpad IT402-X (Ver. 1.0) (Answer Key) '<<<<<<<<<<<<<
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Skills Development Programme (GSDP) in India in the year 2017, started by the Ministry
of Environment, Forest and Climate Change MoEFCC in partnership with the National Skill
Development Agency (NSDA). It aims to develop green skilled workers having technical
knowledge and commitment to sustainable development. The program supports the
attainment of Nationally Determined Contributions (NDCs), Sustainable Development Goals
(SDGs), National Biodiversity Targets (NBTs) and Waste Management Rules 2016.

2. There are three major problems related to sustainable development. Let us discuss them
one-by-one.

Food: As we are using up more and more land for designing concrete jungles, we are
reducing the land for cultivation of crops. Soil nutrients are also depleting due to pollution
from industries, overgrazing of land etc. Overpopulation is another threat for the shortage
of food all across the world.

Water: The supply of fresh drinking water from rivers and ponds is limited worldwide.
Due to pollution, these water bodies are contaminated, leaving very little water available
for actual use.

Fuel: Forests are cut down for fuel leaving barren land where soil erosion will lead to soil
degradation and a drastic change in climatic conditions. An increase in the consumption of
oil and natural gas has led to an increase in the level of carbon dioxide causing a change
in the climatic conditions. We are using a lot of wood from trees for the construction of
homes and furniture. Extreme weather conditions, such as floods, extreme cold, or heat,
are seen in many places, which affect the people living there.

Goal 14—Life below Water: This goal focuses on protecting life underwater by eliminating
pollution, overfishing, and illegal fishing practices to achieve healthy and productive
oceans. Oceans, seas, and rivers are home to more than 2 million estimated species.
These underwater species provide life support and regulate our climatic conditions. We
all need to conserve and consciously use the world’'s oceans, seas, and marine resources
to make them sustainable for present and future generations. For example, Integrated
Coastal Zone Management (ICZM) Project aims to conserve and manage coastal and
marine ecosystems, biodiversity, and resources sustainably, supporting the livelihoods
of coastal communities while protecting marine habitats.

Goal 15—Life on Land: This goal ensures stopping further damage to life on earth by
deforestation, loss of natural habitats, and land degradation so that all nations together
can work to conserve and sustainably use biodiversity and ecosystems. By stopping the
cutting of trees and forests, land degradation, fragmentation and overgrazing will help
in preserving and restoring terrestrial ecosystems such as forests, wetlands, grasslands,
drylands and mountains. Cutting trees is leading to soil erosion and making land dry and
unusable for cultivation. For example, National Afforestation Programme (NAP): Aims
to increase forest and tree cover to enhance biodiversity, combat desertification, and
mitigate climate change impacts in India.
)
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a. Many countries and companies are still giving priority to their own profits, at the cost of
overuse and exploitation of natural resources.

b. Many countries want to show their power and prove themselves best by using their nuclear
weapons and encouraging the destruction of nature and mankind. In such conditions,
ensuring world peace is a global challenge.

¢. Many countries are still not serious about taking the initiatives and implementing the
policies in favour of SDGs. Due to this lack of interest, there is a huge world population
which is still insensitive towards its needs.

Three Sustainable Development Goals (SDGs) Relevant to My Country

* Quality Education (SDG 4)
o Provide free and accessible education to all children, especially in rural areas.
o Improve teacher training and digital learning facilities.
o Implement skill-based education to enhance employability.

« Clean Water and Sanitation (SDG 6)
o Ensure safe drinking water supply in both urban and rural areas.
o Implement strict regulations to prevent water pollution.
o Promote water conservation through rainwater harvesting and wastewater treatment.

« Decent Work and Economic Growth (SDG 8)
o Support startups and small businesses with financial aid and mentorship.
o Encourage sustainable industries that generate employment.
o Ensure fair wages and better working conditions for all workers.

By focusing on these goals, my country can improve its overall development while ensuring
sustainability.

I will take the following measures:
 Politely request vendors to use paper or cloth bags instead of plastic.

« Carry my own reusable bags and encourage others to do the same.
« Explain to vendors how plastic harms the environment and affects human health.
« Suggest using biodegradable or recycled packaging.

« Request local authorities to promote awareness campaigns and provide eco-friendly bag
alternatives.

I will help in the following ways:

« Educate neighbors about proper waste segregation into dry, wet, and hazardous waste.
« Encourage the use of separate bins for biodegradable and non-biodegradable waste.

+ Organize a clean-up drive with volunteers in the community.

+ Contact the local municipal authorities for proper disposal and recycling.
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« Promote composting for biodegradable waste like food scraps and leaves.
3. We can make home manure by following these steps:

« Collect fruit and vegetable peels, tea leaves, and other organic waste.

+ Put them in a compost bin or a pit in the garden.

« Add dry leaves or newspaper to balance moisture and airflow.

« Mix the compost occasionally and keep it slightly moist.

After4-6 weeks, the compost will turn into nutrient-rich manure, which can be used for plants.

Previous Years' Questions

2. « Use of renewable energy sources: Promoting solar, wind, and hydropower instead of fossil
fuels.

« Energy efficiency measures: Encouraging LED lighting, energy-efficient appliances, and
sustainable transportation.

Conserving natural resources: Using resources like water and energy efficiently to reduce waste.

4. Recycle: Processing used materials (like paper, plastic, and glass) into new products to reduce
waste and conserve natural resources.

5. UNEP (United Nations Environment Programme)
6. Deforestation: Large-scale clearing of forests for urbanization and agriculture.
« Pollution: Air, water, and soil pollution harming ecosystems and biodiversity.
+ Climate change: Rising temperatures and extreme weather events disrupting natural habitats.

« Overpopulation: Excessive human population leading to overconsumption of natural
resources.
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Answer Key
Part-B: Subject Specific Skills

Digital Documentation (Advanced)

m using LibreOffice Writer

Find on GooOgle

Do it yourself.

¢

(Page-143)

Find on Google p,.c160)

Do it yourself.
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_______

{_/ {Page-170

___________

1. Insert 2. Parallel Text wrapping 3. Crop

‘‘‘‘‘‘‘‘‘

___________

1. True 2. False 3. True 4. False
8 Unsolved
Section A (Objective Type Questions)
A. 1. c 2. a. 3. a. 4. a. 5. b. 6. a. 7. c
8. b. 9. d. 10. c. 11. d. 12. a. 13. a. 14. c
B. 1. Gallery 2. N# 3. Bring to Front 4. Solarization
5. Media — Scan 6. Modifying 7.7 8. Pop Art
P
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C. 1. True 2. False 3. False 4. True 5. True
Section B (Subjective Type Questions)

A. 1. Anchoring refers to the reference point for the graphics. An image always has an anchor
point. It specifies the relationship between the graphic and the text surrounding it. Anchoring
allows an image to retain its position to a page, paragraph, character or frame. So whenever
a page, paragraph, character or frame is aligned, the anchored image moves along with it.

2. The Alignment, Arrange, and Wrap features of an image can be accessed under the Format
menu.

3. To Foreground: Moves the drawing object in front of the text.
To Background: Moves the drawing object behind the text.
4. Four butons used in Table of Contents are as follows:
« The N# button inserts the heading number or list number of the entry.
« The E button represents the entry text.
e The T button represents a tab stop.
« The # button represents the page number.
5. Four effects of Filter tool are as follows:

« Solarization: It makes the image wholly or partially reverse in the tone. Used in
photographs. Dark appears light and light appears dark.

« Aging: It brings the impact of time with the age.
» Posterize: It makes the image appear like a poster with less colour combinations.
« Pop Art: It displays the image in the modern art style.

B. 1. Cropping an image involves removing unwanted portions of the image to focus on a
specific area or to improve its composition. It is equivalent to using a scissor to cut the
unwanted part.

Resize an Image means altering the image in a document either by increasing its size or by
decreasing its size. Resizing is the process of reducing or enlarging the size of the image.
The resizing of a picture will alter the resolution of a picture.

2. To crop an image, perform the following steps:

Step 1: Select the image in the Writer document.

Step 2: Click on the Crop Image tool from the Image toolbar. Notice that the eight little
squares surrounding the image will be transformed into blue handles.

Step 3: Click and drag the handles on the image to adjust the crop region as desired. You
can crop from any side or corner.

3. The steps to group the objects are as follows:

Step 1: Select multiple objects by using mouse click and holding the Shift key.
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Step 2: Click on the Format — Group option and then select the Group option from the

sub menu.
OR
Right-click on the selected objects and then select the Group option from the context
menu.
OR
Select the Group option from the Drawing Object Properties toolbar.
4. Option Description

None The text is placed above and below the image.

Before The text is placed before the image.

After The text is placed after the image.

Parallel Text flows around the image. Moving an image will rearrange the text

on the page.

The image comes above the text. In this case the image should have

Th h
roug transparency so that the text below it is visible properly.

Optimal prevents text from being placed to the side of the image if the

Optimal
ptima spacing between the image and the margin is less than 2 cm.

5. After reviewers have made changes and provided comments, LibreOffice Writer enables
you to compare the original document with the reviewed version. You can then select the
option(s) that best suit your needs.

To compare the document, perform the following steps:
Step 1: Open the reviewed document.
Step 2: Select the Edit Track Changes Compare Documents option from the Menu bar.

OR Click the Compare Non-Track Changed Document button in the Track Changes
toolbar. The Compare to Original Document dialog box opens.

Step 3: Browse and select the original file to be compared.
Step 4: Accept or reject the desired changes by clicking the respective buttons.
Step 5: Click the Close button to close the dialog box when done.
Step 6: Save the edited file.
1. Shinjini can use the following features to design an invitation card:
« Page Layout: Set size, orientation, and margins.
« Templates: Pre-designed invitation templates for quick customization.
« Fonts & Text Styles: Decorative fonts and color formatting for an elegant look.

+ Images & Clipart: Adding family photos or anniversary-themed graphics.
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Borders & Backgrounds: Custom borders and colored backgrounds for a festive touch.

Shapes & Symbols: Decorative elements like hearts, rings, or floral designs.

2. The image file saved in a computer can be inserted using any of the given methods:

Inserting an image using Insert menu

Inserting an image using Drag and Drop method
Inserting an image using Copy and Paste option
Inserting an image using a scanner

Inserting an image by linking

Inserting an image from LibreOffice gallery

. The steps to draw a rectangular box are:

« Go to Insert — Shape — Basic Shapes — Rectangle.

+ Click and drag to draw the rectangle on the document.
« Adjust the size, color, and border as needed.

Two text wrapping options are:

« None: The text is placed above and below the image.

- Before: The text is placed before the image.

. The steps to give a watermark effect to an image are:

Step 1: Select the image in the document on which you want to apply Watermark effectl.
The Image toolbar appears.

Step 2: Click on the Image Mode tool. A drop-down menu appears.

Step 3: Select Watermark option and see the effect on the image.

The steps to group different objects are:

Step 1: Select multiple objects by using mouse click and holding the Shift key.

Step 2: Click on the Format — Group option and then select the Group option from the
sub menu.
OR
Right-click on the selected objects and then select the Group option from the
context menu.
OR

Select the Group option from the Drawing Object Properties toolbar. .

4. The Table of Contents and Index feature in LibreOffice Writer helps in creating an index
page. The steps to use this feature are:

Step 1: Go to Insert — Table of Contents and Index — Index Entry.

8.0
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21.

22.

23.
24.

25.

Step 2: Select the text to include and click Insert.

Step 3: After adding entries, go to Insert — Table of Contents and Index — Index.
Step 4: Choose the index type, format, and click OK to generate the index.

c. Ais true but R is false.

c. Ais true but R is false

a. Statement 1 is true, statement 2 is true.

a. Statement 1 is true, statement 2 is true.

Previous Years' Questions

. b. 2. C 3.d 4. b. 5. b. 6. d.

The steps to group the objects are as follows:
Step 1: Select multiple objects by using mouse click and holding the Shift key.

Step 1: Click on the Format Group option and then select the Group option from the sub
menu.

OR

Right-click on the selected objects and then select the Group option from the context
menu.

OR
Select the Group option from the Drawing Object Properties toolbar.
d. 9. Fill Format Mode 10. d. 11. a. 12. c. 13. a.
b. 15. ¢ 16. c. 17. b. 18. a. 19. d. 20. a.
Word processor
+ Select the text you want to highlight.
+ Click on the Highlight Color icon in the Formatting toolbar.
+ Choose the desired color from the options.
Insert
- Page number
+ Document title
+ Date and time
« Author name
Section breaks divide a document into different sections.

They allow different formatting settings in each section, such as page orientation, columns,
and headers/footers.
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27.
28.
29.

30.

31.

32.

33.

34..

35.
36.
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Enter key

Header

Title Case

Atemplate is a predefined layout or a blueprint of a document with saved formatting features
like font styles, logos, borders, colour pattern, text design, etc. Later a document is created
using these pre-defined templates.

A style is a collection of different formatting saved by a specific name and then applied to
different sections of the documents containing text, tables, lists, etc.

Place the Cursor: Position the cursor where you want to insert the page break.
Go to the Insert Menu: Click on the “Insert” menu in the toolbar.

Select Page Break: From the dropdown, click on “Manual Break” and then choose "Page
Break” in the dialog box.

Click OK: Confirm the action by clicking “"OK.”

Upper Case: This formatting option converts all selected text into capital letters. It is useful
for emphasizing headings or important information in a document.

Sentence Case: This option capitalizes the first letter of the first word in a sentence while
keeping the rest of the text in lowercase, following standard grammatical rules.

Strikethrough: This text effect draws a horizontal line through the selected text, indicating
that it is deleted or no longer relevant but still visible for reference.

Charts help represent data visually. The different types of charts include:

a.

Bar Chart: Displays data in rectangular bars, useful for comparing categories.
Pie Chart: Represents data as a circle divided into slices, showing proportions.
Line Chart: Uses lines to connect data points, ideal for tracking trends over time.
Column Chart: Similar to a bar chart but with vertical bars.

Scatter Chart: Shows relationships between two variables using dots.

Open OpenOffice Writer and place the cursor where you want the table.

Go to the "Table” menu and select “Insert Table.”

Specify the number of rows and columns in the dialog box.

Click "OK" to insert the table into the document.

Enter data into the table and use formatting options to adjust its appearance.

Four points that should be included in your resume or curriculum vitae are as follows:

Personal Information: Name, contact details, and professional title.

8.0
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Education: Academic qualifications, including institutions attended and degrees obtained.

Work Experience: Previous job roles, internships, or relevant experience with responsibilities
and achievements.

Skills: Key skills related to the job, such as technical skills, soft skills, or certifications.

37. Use of Header and Footer in a document:

Headers appear at the top of each page and can include titles, company names, or page
numbers.

Footers appear at the bottom of each page and can contain details like copyright
information, document versions, or additional notes.

38. Advantage of using a Document Template:

Saves time by providing a pre-designed format.
Ensures consistency in formatting across documents.
Reduces errors by including predefined sections.

Enhances professionalism in document presentation.

Steps to use a Document Template:

1.

oA~ wen

Open the word processor (e.g., Microsoft Word).
Click on File and select New.

Choose Templates and browse available options.
Select a template and click Create or Open.

Edit the content as required and save the document.

2% video based question Page-206

Do it yourself.
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Do it yourself.
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Do it yourself.
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Do it yourself.
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Do it yourself.
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1. The Merge with dialog box opens.
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________

Electronic Spreadsheet (Advanced)

m using LibreOffice Calc

2. After reviewers have made changes and provided comments, LibreOffice Writer enables you to
compare the original document with the reviewed version. You can then select the option(s) that

best suit your needs.

3. Comments in spreadsheets serve the purpose of providing additional information, context, or
explanations about specific data or formulas within the spreadsheet. This feature is particularly
useful for collaboration, as it allows multiple users to understand the justification behind certain
entries or calculations. Additionally, comments help maintain the integrity and transparency of
the spreadsheet by documenting the thought process behind each data point.

8 Unsolved

A. 1. b 2. C
8. b. 9. a.

B. 1. .ods 2. name
6. Absolute path

C. 1. False 2. True

) 200000 00%

7. cell reference

Section A (Objective Type Questions)

5. c 6. d. 7. c.

4. = (equal to) 5. Internet
8. deleted
5. True 6. True 7. True
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Section B (Subjective Type Questions)

1. You can rename a default name or existing name of the sheet at any time. To do this, perform
the following steps:

Step 1:
Step 2:
Step 3:

Double-click the sheet in the Sheet tab.
Delete the old name and type a new name of your choice in the Name text box.

Click on OK button.

2. + Relative Hyperlink: Points to a file or webpage relative to the location of the document.
If moved, the link may still work.

 Absolute Hyperlink: Contains the full path (URL or file location). The link remains unchanged
regardless of the document’s location.

3. The steps to show or hide comment in a spreadsheet are:

Step 1:
Step 2:

Select the cell containing comment that you want to show or hide.

Right-click on the selected cell and select the Show or Hide Comment option from
the context menu.

4. To use this feature, you need to first enable it. To do this, perform the following steps:

Step 1:

Step 2:

Step 3:

Step 4:
Step 5:

Select the Tools — Options option in the Menu bar.
The Options dialog box opens.

Click on the LibreOffice category. The LibreOffice Base category expands and displays
the options.

Select the Advanced option. The options related to advance features of LibreOffice
displays on the right-side of the Options dialog box.

Select the Enable macro recording (may be limited) check box.

Click the OK button.

5. The steps to compare the files are as follows:

Step 1:
Step 2:
Step 3:
Step 4:
Step 5:

Open edited spreadsheet.

Select the Edit Track Changes option from the Menu bar.
Select the Compare Document option from the submenu.
Select the original spreadsheet and click on Open button.

Accept or reject the changes and click on Close button.

6. To do this, follow the steps given below:

Step 1:
Step 2:

fiol

Create a new spreadsheet.

Select the Tools — Macros option from the Menu bar.
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Step 3: Select the Record Macro option from the submenu.

Step 4: Add the names of five cities, format the list with different font colours, cell
background colour.

Step 5:  After you are done with the steps of your formatting the spreadsheet. Click on the
Stop Recording button.

B. 1. File Conflicts — If multiple users edit the document simultaneously, conflicts may arise
when saving changes.

Permission Issues — Some users might not have the required access rights to save the
document.

Network Problems —If the document is stored on a shared network or cloud, connectivity
issues can prevent it from being saved properly.

File Locking — The document may be locked by another user, preventing others from saving
their changes.

Auto-Save Overwrites — If auto-save is enabled, manual edits might get lost if another
user’'s changes overwrite them.

2. Recording Macros Let us create a simple macro of storing the names of five cities and
formatting it in a different colour, font and size.

To do this, follow the steps given below:

Step 1: Create a new spreadsheet.

Step 2: Select the Tools Macros option from the Menu bar.
Step 3:  Select the Record Macro option from the submenu.

Step 4: Add the names of five cities, format the list with different font colours, cell
background colour.

Step 5: After you are done with the steps of your formatting the spreadsheet. Click on the
Stop Recording button.

This will open the Basic Macros dialog window to save and run the created macro.
Step 6: Click on (+) sign in front of My Macros — Standard — Modules1.

Step 7:  The name of the macro by default is Main and is saved in the Standard Library in
Module1. You can change the name of the macro in the Macro Name Textbox as
“CityMacro”. Note that :If all the macros will be given the same name then they will
overwrite the previous Macro created by that name.

Step 8: Click on Save button. The macro is saved.
Running a Macro

After the macro is recorded, you can run it as many times as you want until you delete it
from the computer.

8.0
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The steps to run a macro are as follows:

Step 1:

Step 2:
Step 3:

Step 4:

Step 5:
Step 6:

Create a new spreadsheet or open an existing spreadsheet where you want to run
a macro.

Select the Tools Macros option from the Menu bar.

Select the Run Macro option from the submenu. The Macro Selector dialog box
opens.

Open the folders by clicking on (+) sign in front of My Macros — Standard —
Module1.

The list of macros within it will be displayed.
Select the CityMacro macro.

Click on the Run button. The macro runs in the spreadsheet.

3. Follow the given steps to insert data from an external source:

Step 1:
Step 2:
Step 3:

Step 4:

Step 5:
Step 6:

Step 7:

Select the cell where you want to insert data from external source.
Select the Sheet — External link option from the Menu bar.

Type the path of the external data source in the URL of External Data Source text
box or click on the Browse button to select the file.

Navigate the location and select the file. Then, click on the Open button.

The path of the external source is displayed in the URL of External Data Source text
box.

Select the named ranges or tables you want to insert.

Select the Update every check box to specify the time by which the selected ranges
or tables are updated automatically.

Click on OK button.

4. Whenever a macro is created the code generated equivalent to the instructions given in a
recorded macro are stored internally in LibreOffice Calc in a programming language called
BASIC. It is also possible to view and thus edit the code of a macro, if you have knowledge

of BASIC.

You can view the code generated for the macros by following the given step:

Step 1:
Step 2:

Select the Tools — Macros option from the Menu bar.

Select the Organize Macros — Edit Macros option from the submenu. This will open
a code window. You will see that the code begins with sub followed by a macro
name and ends with End Sub.

5. The steps to create a simple macro function are as follows:

Step 1:

fiol

Create a new spreadsheet.
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Step 2:
Step 3:

Step 4:

Step 5:

Step 6:
Step 7:

Select the Tools — Macros option from the Menu bar.

Select the Organize Macros — Edit Macros option from the submenu. The Macro
code window opens.

Create an empty line after Sub main and End Sub.
Write the given code:

Function Displaycontent ()
Displaycontent () ="Macros are interesting”
End Function

The code window after the given code is entered.

Press Ctrl+S or click on Save button on the Standard toolbar to save the changes
in the code window.

Close the code window.
Now, when we type =Displaycontent() in any cell in the sheet.

Then, you will see the text Macros are interesting displayed automatically in a cell.

6. To format the comment, perform the following steps:

Step 1:
Step 2:

Step 3:

Step 4:

Step 5:
Step 6:

Step 7:
Step 8:

Step 9:
Step 10:

Select the cell containing comment that you want to format.

Right-click on the selected cell and select the Show Comment option from the
context menu.

The comment is displayed in the spreadsheet.

Right-click on the comment box. A context menu appears that contains the various
option for formatting a comment box, such as Line, Area, Positing and Size, etc.

Select the Line option to change the line style of the comment box. The Line dialog
box opens.

Select the desired option in the respective tab to apply the line related formatting.

Select the Area option to change the background, shadow, and transparency of
the area of the comment box. The Area dialog box opens.

Select the desired option in the respective tab to apply the area related formatting.

Select the Text option to change the text position, animation and column in a
comment box. The Text dialog box opens.

Select the desired option in the respective tab to apply the text related formatting.

Select the text in the comment box.

|
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Step 11: Right-click on the selected text in the comment box. A context menu appears that
contains the various option for formatting a text in the comment box, such as Line,
Area, Positioning and Size, etc.

Step 12: Select the Character option to change the font colour, font size, font type, font
effect, font position, and text highlight of the text in a comment box. The Character
dialog box opens.

Step 13: Select the desired option in the respective tab to apply the font and character
related formatting.

Step 14: Select the Paragraph option to change the indentation and spacing, alignment, and
tab setting of the paragraph in a comment box. The Paragraph dialog box opens.

Step 15: Select the desired option in the respective tab to apply the paragraph related
formatting.

7. Data analysis plays a pivotal role in modern organisations for numerous reasons. Data analysis
helps organisations in various tasks such as informed decision-making, problem-solving,
understanding customer behaviour, improving efficiency, performance evaluation, and risk
management. It is required to study the trends of products required in the local and global
market. It is an important part of many organisations for planning and taking important
decisions for the progress of the company.

The LibreOffice Calc offers several built-in tools for data analysis, which are essential for
performing various analytical tasks directly within the spreadsheet software. These tools
include Data Consolidation, What-if Analysis, Goal Seek, solver and many more.

1. The best tool for Amit is the Consolidate feature in a spreadsheet.
Step 1: Open the spreadsheet and go to the sheet where the consolidated data is needed.
Step 2: Select the range containing marks (e.g., B2:B6) in Sheet1.
Step 3: Go to Data > Define Range, give it a name (e.g., Test1), and click OK.
Step 4: Repeat Steps 2-3 for Sheet2 (Test2) and Sheet3 (Test3).
Step 5: Create a new sheet named Final Average.
Step 6: Click on cell B2 where you want to display the average marks.
Step 7:  Go to Data — Consolidate.
Step 8: In the Copy results to section, ensure B2 is selected.

Step 9:  From the Source data range drop-down, choose the range name (Test1), then click
Add.

Step 10: Repeat for Test2 and Test3 to add all test ranges.
Step 11: In the Function drop-down, select Average.

Step 12: Click on Options and check Link to source data to make the result dynamic.
0
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Step 13: Click OK.
2. The best tool for Rohit is Goal Seek in a spreadsheet.
Step 1:  Open the spreadsheet and enter the marks of English and Math in separate cells.
Step 2: Create a formula to calculate the total marks needed for 80% in another cell.
Step 3: Click on Tools and select Goal Seek from the menu.
Step 4: In the Formula cell, select the total marks formula cell.
Step 5: In the Target value, enter the required total marks for 80%.
Step 6: In the Variable cell, select the cell where IT marks will be entered.
Step 7 Click OK, and the spreadsheet will calculate the required IT marks.
3. They should use the Share Document feature.
Step 1: Open the spreadsheet in LibreOffice Calc.
Step 2: Click on Tools and select Share Document from the menu.
Step 3:  Check the box that says Share this document with others.
Step 4: Click OK to enable sharing.
Step 5: Save the document, and now both users can edit it simultaneously.
4. The best tool for Rohan is Goal Seek in a spreadsheet.
a. The Track Changes feature should be used.
b. Step 1: Open the spreadsheet and go to Edit - Changes — Record.
Step 2: Enable Record Changes to track modifications.
Step 3: Click on Edit — Changes — Show to view changes.
c. Step 1: Right-click on the edited cell.
Step 2: Select Insert Comment from the menu.
Step 3: Type the comment explaining the changes.
Step 4: Click outside the comment box to save it.
d. Step 1: Go to Edit » Changes — Accept or Reject.
Step 2: Review each change and accept or reject it.
Step 3: Click OK to finalize the changes.
6. a. Step 1: Right-click on the sheet tab at the bottom.
Step 2: Select Insert Sheet from the menu.
Step 3: Choose the number of sheets and click OK.
b. Step 1: Right-click on the sheet tab at the bottom.

8.0
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Step 2: Select Rename Sheet from the menu.
Step 3: Enter the new name and press Enter.
c. Step 1: Right-click on the sheet tab of the unwanted sheet.
Step 2: Select Delete Sheet from the menu.
Step 3: Confirm the deletion by clicking OK.
d. Step 1: Select the cell where you want to insert the hyperlink.
Step 2: Click on Insert — Hyperlink.
Step 3: Choose Web and enter the company’s website URL.
Step 4: Click OK to apply the hyperlink.
b. Both A and R are true but R is not the correct explanation of A.
a. Both A and R are true and R is the correct explanation of A.

d. Statement 1 is false, statement 2 is true.

Previous Years' Questions

. C 2. d. 3. d. 4. c. 5. c 6. d.

In LibreOffice Calc, data consolidation refers to the process of combining data from multiple
sheets of the spreadsheet into a single sheet by using different built-in functions like sum(),
max(), min(), average(), etc. Data consolidation is used to summarise the information for
analysing or reporting purposes. The data of similar type from different sheets in the same
spreadsheet is picked up, consolidated and saved for further data analysis.

Cell references consist of a column letter followed by a row number (e.g., A1, B2, C3, etc.).
Cell reference of a range of cells is starting cell address and ending cell address separated
by colon(:) in between. For example, C10:C20, A1:B6 and C5:D10.

9 « Internet: Links to a website or web page by entering the URL. You can customize the text
to display as the hyperlink.
« Mail:Creates a link that opens a pre-addressed email. Enter the recipient’s email and
subject. Set custom link text.
« Document:Links to another file on your computer or network. Browse to select the file
and optionally link to specific sections like sheets or images. Customize the hyperlink text.
« New Document:Creates a hyperlink that opens a new document. Choose the file type
(e.g., spreadsheet), name it, and select whether to edit now or later. Set link text.
10. c.
11. a.
12. 1
13. d.

,
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14.

15.

16.
17.
18.
19.
20.
21.
22.
23.
24.
25.
26.
27.
28.
29.
30.
31.

32.

33.
34.

35.

An example of a statistical function in Calc is =AVERAGE(A1:A10), which calculates the average

of the selected range.

a. Scenario: A Scenario is a tool used to save and compare different sets of data values
(what-if analysis) in the same worksheet without changing the actual data.

b. Goal Seek: Goal Seek is used to find the input value required to get a desired result from

a formula. It works with one variable.

b.

b.

b.

Goal Seek, Unknown Variables
Goal Seek

b.

a.

b.

d.

a.

d. All the Statements are correct
b. Statement Il is wrong

a.

SUM

Horizontally or vertically

a. =SUM(B3:E3)

b. Sorting (Ascending Order)
¢. =MAX(B5:E5)

d. =AVERAGE(B3:B6)

e. =C5-C4

+ Highlighting cells based on values (e.g., greater than 500)

+ Applying color scales (e.g., gradient from red to green based on values)

File Menu

Freezing in a spreadsheet means locking specific rows or columns so they remain visible
while scrolling through the rest of the sheet. This feature is useful for keeping headers or

important data in view.

a. AutoSum

DI2IXPX0).
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36.

37.
38.
39.

40.

41.
42.

P
6,

b. Right-click on Sheet1 — Click Rename — Type Cost Sheet — Press Enter
¢. Use Freeze Panes
* Go to View — Freeze Cells — Freeze First Row (or Column)
This will keep the headings visible while scrolling.
a. In cell F2, type this formula:
=C2+D2
Then drag the fill handle down to F6 to apply the formula for the other players.
b. Feature used for arranging the Rank from Highest to Lowest:
Sort Descending
¢. Formula to find the Player with Maximum TOTAL in F7:
=MAX(F2:F6)
d. Formula to find the Average of Points in C7:
=AVERAGE(C2:C6)
e. To change Orientation of the Page from Landscape to Portrait:
« Go to Format — Page Style.
« Under the Page tab, in Paper Format, select Portrait.
Above, left
b.
Five types of charts available in a spreadsheet:
« Column Chart: Displays data in vertical bars to compare values across different categories.
 Line Chart: Shows trends over time using a continuous line.

« Pie Chart: Represents data as a circular graph divided into sections (slices) to show
proportions.

« Bar Chart — Similar to a column chart but with horizontal bars.
 Scatter Chart — Displays relationships between two sets of data points.

Conditional Formatting —It allows users to format cells based on conditions (e.g., highlighting
values above a certain number).

Sort — Arranges data in ascending or descending order based on selected columns.
Filter — Allows users to display only specific data based on set criteria while hiding the rest.
C.
a. Formula to calculate AMOUNT (RENT * DURATION) in E2:
=B2*D2
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b. Formula to calculate TAX (10% of AMOUNT) in F2:
=E2*10%

c. Formula to calculate BILLAMOUNT (AMOUNT + TAX) in G2:
=E2+F2

d. Formula to find the highest RENT in B8:
=MAX(B2:B7)

e. Formula to count the number of occupied rooms in C8:

=COuU NTIF(C21C7,"OCCU PIED")

c:s u

GROUP DISCUSSION f& ﬂ Page-290

Do it yourself.

&i Video based question Page-291

Do it yourself.

LAB ACTIVITY Page.291
age-

Do it yourself.

CLASS ACTIVITYG
Page-292

Do it yourself.

Database Management System using

m LibreOffice Base

Find en Google p,ee-301)

Do it yourself.

8 iz Bee

__________

________

a. * STATIONARY Table: SID (Stationary ID) is the Primary Key because it uniquely identifies each

item.
£
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« CONSUMER Table: CID (Consumer ID) is the Primary Key as it uniquely identifies each
consumer.

b. « CNAME (Consumer Name) can be an Alternate Key because it is unique for each consumer
and can serve as a unique identifier if CID is not used.

¢. Candidate keys are attributes that can uniquely identify a row. In the STATIONARY table:
« SID (Primary Key)

+ (SNAME, COMPANY) (A combination of SNAME and COMPANY could uniquely identify a
record)

d. SID in the CONSUMER table is the Foreign Key because it references SID (Primary Key) in the

STATIONARY table, establishing a relationship between the two tables.

2% video based question Page-315

Do it yourself.
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________

1. a. Database Name: FlowerShopDB

b. Customers Table (Customers)

CustomerID (INT, Primary Key)
Name (VARCHAR, 100)
ContactNumber (VARCHAR, 15)
Email (VARCHAR, 100)

Address (TEXT)

Orders Table (Orders)

.

OrderID (INT, Primary Key)

CustomerID (INT, Foreign Key referencing Customers Table)
OrderDate (DATE)

DeliveryDate (DATE)

TotalAmount (DECIMAL, 10,2)

Stock Table (Stock)

fiol

ProductID (INT, Primary Key)
ProductName (VARCHAR, 50)
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* Quantity (INT)
e PricePerUnit (DECIMAL, 10,2)
« Supplier (VARCHAR, 100)
c. *« CustomerID (Primary Key in Customers Table)
» OrderID (Primary Key in Orders Table)
» ProductID (Primary Key in Stock Table)

2. a. Yes, records can be created without a primary key, but there will be no uniqueness
enforcement, which may lead to duplicate entries.

b. Yes, the table structure can be edited to add AdmNo as a primary key.
c. *« Open the database in MS Access or SQL database system.

« Select the table (e.g., STUDENT).

+ Click on "Design View" or "Modify Table.”

 Select the AdmNo column.

» Click on "Set as Primary Key.”

+ Save the changes.

8 viz Bee
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1. Books in Stock Table (BooksStock)
» BookID (Primary Key)
- Title
« Author
* Publisher
- ISBN
* QuantityAvailable
Books Issued Table (BooksIssued)
+ IssuelD (Primary Key)
» BookID (Foreign Key referencing BooksStock.BookID)
« StudentID
» IssueDate
* DueDate

« ReturnDate

8.0
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Books Lost/Damaged Table (BooksLostDamaged)
« RecordID (Primary Key)
+ BookID (Foreign Key referencing BooksStock.BookID)
« StudentID
« Status (Lost/Damaged)
* ReportDate
* FineAmount
2. + BooksStock and Bookslssued are linked using BookID.
» BooksStock and BooksLostDamaged are linked using BookID.
« The relationships can be named as:
« Stock_Issue_Relationship (BooksStock — Bookslssued)
« Stock_Lost_Relationship (BooksStock — BooksLostDamaged)

3. Yes, referential integrity ensures that a book issued must exist in the BooksStock table. If a book
is deleted from BooksStock, all its related records in BooksIssued must be handled (deleted or
updated). This prevents orphan records in Bookslssued.

4. Relationship once created can be easily removed by deleting them using the given steps:
Step 1: Click on Tools menu. A drop-down menu will appear.
Step 2: Select Relationships option from the menu. The Relation window will appear.

Step 3: Right-click on the relationship thread and select the Delete option.

=S
L -'\Page—341

________

_______

« SELECT ITEMNO, NAME, PRICE, QUANTITY, (PRICE * QUANTITY) AS AMOUNT FROM ITEM;
e SELECT * FROM ITEM WHERE PRICE < 50;

« SELECT NAME, PRICE FROM ITEM ORDER BY PRICE ASC;

« SELECT * FROM ITEM WHERE NAME LIKE ‘S%’;

Find on Google o, 341,

Do it yourself.
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1. The Form Design toolbar is used to add a label in the Design View of a form.
2. The Dropdown property (Yes/Enabled) must be set to add a calendar drop-down to a date field.

3. The Date Field button allows users to insert a date field with a built-in calendar picker, making
it easier to enter dates.

4. The Form Controls toolbar contains various tools to add or edit controls on the form in LibreOffice
Base.

8% video based question Page-370

Do it yourself.

8 Unsolved
Section A (Objective Type Questions)
A. 1. d 2. C. 3. c 4. a. 5 a 6. a. 7. b.
8. d. 9 c 10. a.
B. 1. Forms 2. Primary 3. Query 4. Alternate 5. Record
6. Candidate 7. Data type 8. Datasheet 9. Image 10. Sorting
C. 1. True 2. True 3. True 4. True 5. True 6. False 7. True
8. True 9. True 10. True
D. 1. d 2. e 3. a 4. b. 5 c

Section B (Subjective Type Questions)
A. 1. Entry Required ensures that a value must be entered in the field before saving a record, while
Default Value automatically fills in a predefined value if no input is given by the user.

2. Data Redundancy refers to the unnecessary repetition of data within a database, which leads
to storage wastage and inconsistency in data management.

3. Referential Integrity ensures that relationships between tables remain consistent by enforcing
constraints.

Referential Integrity helps in the following conditions:

« Whenever a new record is added in a table with the foreign key then it ensures that the
value added should exist in a primary key of the other linked table.
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« Update or deletion in the Table with the primary key is not allowed if the matching record
exists in the foreign key of the other table.

4. Reports are formatted presentations of data retrieved from the database that help users
analyze and summarize information effectively.

5. A data model is a conceptual framework that defines how data is structured, stored, and
manipulated in a database.

6. The Memo data type is used to store large amounts of text, such as comments, descriptions,
or long notes.

7. Queries help users retrieve, filter, and manipulate data based on specific conditions.
8. There are two ways: using Design View or Datasheet View.

9. The Default Value property automatically assigns a predefined value to a field when a new
record is created.

10. Design View allows users to define and modify the structure of a table, including field names,
data types, and properties.

Datasheet View enables users to enter, edit, and view data in a tabular format.
1. Some advantages of the database are as follows:

« Organised Storage: Databases employ structured formats and indexing mechanisms
to organise data efficiently, which allows fast and accurate retrieval of information.
This organisation typically follows a predefined schema, ensuring data integrity and
facilitating query operations.

« Data Analysis: DBMS systems provide powerful querying capabilities that enable users
to perform various analyses on the stored data. Aggregate functions, sorting, filtering,
and grouping operations make it easy to understand such as maximum, minimum,
average, or other statistical measures from the data.

* Reduces Data Redundancy: Data Redundancy means keeping multiple copies of the
same data in a System. Using DBMS, the data in tables are interlinked through a common
column to avoid duplicate entries. Data constraints are applied to store data based on
different criteria.

« Sharing of Data: It means data can be accessed by multiple users at the same time.
Different users can have different rights and privileges to access data. Some may have
the right to only view the data. Some may have permission to modify the data. Database
administrators manage the rights and privileges for sharing data through a centralised
system.

2. In LibreOffice Base, three types of relationships can be created:

¢ One-to-One Relationship: Each record in Table A is linked to one record in Table B.
Example: A person and their passport. It is represented as a 1:1 relationship.

« One-to-Many Relationship: A single record in Table A can be linked to multiple records in
Table B. Example: A teacher and students in a class. It is represented as a 1:n relationship.
|
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Many-to-Many Relationship: Multiple records in Table A can be associated with multiple
records in Table B. Example: Students and courses in a university. It is represented as a
n:n relationship.

3. Atable in a database can be created in the following ways:

Using Design View: Allows users to define fields, data types, and properties manually.
Using Datasheet View: Users can enter data directly, and fields are created automatically.
Using SQL Commands: Users can create tables using SQL commands like CREATE TABLE.
Using Table Wizard: Provides predefined templates to quickly set up tables.

4. Sorting is the process of arranging data in a particular order, either ascending or descending.
It helps in analyzing and organizing data efficiently. Sorting can be done in two ways:

Ascending Order: Data is arranged from smallest to largest (e.g., A-Z, 0-9).

Descending Order: Data is arranged from largest to smallest (e.g., Z-A, 9-0).

5. An existing table in a database can be opened in the following ways:

.

Method 1: Open the database file, navigate to the “Tables” section, and double-click the
desired table.

Method 2: Right-click the table and select either “Open” (to view data) or “Edit” (to modify
structure).

Feature Forms Report
Purpose Used for data entry and Used for presenting data in a
modification structured format
User Interaction Allows user input Read-only, does not allow data entry
Formatting basic formatting for better Advanced formatting for
usability presentation
Example Customer registration form Sales summary report

7. The Forms Controls toolbar provides various tools to design and customize forms in a
database. It includes:

.

Text Box: Allows users to input text.
Combo Box & List Box: Provides drop-down selections for choosing predefined options.
Check Boxes & Radio Buttons: Helps in selecting multiple or single options.

Push Buttons: Trigger actions such as submitting data, resetting fields, or navigating
records.

One-to-Many Relationship: One record in the first table can be linked to multiple records
in the second table. Example: A single teacher can teach multiple students.

>>>>>>>>>>>>>> Trackpad IT 402-X (Ver. 1.0) (Answer Key) %?ji



« Many-to-Many Relationship: Multiple records in one table can be related to multiple
records in another table. Example: A student enrolling in multiple courses, and a course
having multiple students.

a. Table
b. Form
c. Report
d. Query
Using Form Wizard and Using Design View
b. « Open the database and go to "Relationships”
+ Add tables and define relationships using Primary Key and Foreign Key

c. * Reports are formatted presentations of data retrieved from a database, used for
analysis and decision-making.

d. Using Report Wizard
a. Both A and R are true and R is the correct explanation of A.
a. Both A and R are true and R is the correct explanation of A.

c. Statement 1 is true, Statement 2 is false.

Previous Years' Questions

.d. 2. C 3. a. 4. c. 5. ¢ 6. C.

Two benefits of creating relationships between tables in a database are as follows:
« Data Integrity: It helps maintain consistency by enforcing referential integrity.
 Eliminates Redundancy: Reduces data duplication, ensuring efficient storage.
a. Forms

Forms allow users to enter, edit, and view data in a user-friendly manner. They provide an
easy interface to interact with database records without directly accessing tables.

b. Reports

Reports are used to present database data in an organized format. They allow data to be
printed or exported in a structured manner, making it easier to analyze and share.

a. SELECT PNAME FROM Product WHERE CATEGORY = ‘DOMESTIC’;

b. SELECT PNAME, PRICE FROM Product WHERE QUANTITY < 50;

¢. SELECT PRICE, QUANTITY FROM Product WHERE PNAME = ‘LAPTOP’;
d. SELECT PNAME, QUANTITY FROM Product WHERE PRICE > 5000;

d.
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1. b
12. d

13.
14.
15.

16.

17.

18.

19.

20.

21.
22.
23.

24,

25.

C.
C.

Sorting arranges data in a specific order, either ascending or descending, based on one or
more fields.

« One-to-One: Each record in one table corresponds to only one record in another table.
+ One-to-Many: A record in one table can be linked to multiple records in another table.
Form: Used for data entry and modification.

Report: Used for data presentation and printing.

« PNAME: Varchar

* RUNS: Integer

a. SELECT * FROM STUDENT WHERE HOUSE = 'GREEN’;

b. UPDATE STUDENT SET MARKS = MARKS + 5 WHERE ADMNO = 1005;

c. SELECT * FROM STUDENT WHERE MARKS < 80;

d. SELECT * FROM STUDENT ORDER BY MARKS DESC;

CREATE TABLE EMPLOYEE (
EMPID CHAR(4),
EMPNAME VARCHAR(15),
DESIGN VARCHAR(20),
SALARY DECIMAL

)i
INSERT
SELECT

« DDL (Data Definition Language): Defines the structure of the database. Example: CREATE,
ALTER, DROP.

« DML (Data Manipulation Language): Modifies the database content. Example: INSERT,
UPDATE, DELETE.

« VARCHAR: Stores variable-length text.
« INTEGER: Stores whole numbers.
BOOLEAN: Stores TRUE/FALSE values.

Forms: Used for data entry and editing.

o o

Reports: Used for presenting data.

Table: Stores structured data.

a o

Primary key: A unique identifier for records in a table.

8.0
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26.

27.

28.
29.

30.

31.

32.

33.

fiol

e. « SELECT -DML

+ ALTER-DDL
« INSERT - DML
- DROP-DDL

A Relational Database Management System (RDBMS) stores data in tables with relationships
between them.

A database server is software that provides database services.
 Primary key: Uniquely identifies records.
« Foreign key: References a primary key in another table.
b.
CREATE TABLE Flight (
Flight_ID CHAR(4),
Flight_Name VARCHAR(25),
Source VARCHAR(30),
Destination VARCHAR(30)
);
a. The Primary Key should be the ID column, as it uniquely identifies each record.
b. INSERT INTO table_name (ID, Department, OPD_DAYS, Doctor_Name)
VALUES ('H608’, 'Cardiology’, ‘TTS', 'Vinita Wahi’);
c. SELECT * FROM table_name WHERE OPD_DAYS = ‘'MWF’;
DDL (Data Definition Language) is used to define and manage database structures such as
tables, schemas, and indexes.
» Two DDL statements:
1. CREATE - Used to create tables, databases, or other objects.
2. ALTER - Used to modify an existing database structure.
- DBMS (Database Management System): A software application that enables users to store,
retrieve, and manage data in databases. Examples: MS Access, OpenOffice Base.

« RDBMS (Relational Database Management System): An advanced type of DBMS that
stores data in structured tables with relationships among them. Examples: MySQL, Oracle,
PostgreSQL.

+ Primary Key: A unique identifier for each record in a table. It ensures that each row is
unique. Example: ID in a student table.

« Foreign Key: A field in one table that refers to the Primary Key in another table, establishing

a relationship between tables. Example: Student_ID in a marks table referring to ID in the
student table.
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34. - DDL (Data Definition Language): Commands that define database structures.
o Examples: CREATE, ALTER, DROP, TRUNCATE.
« DML (Data Manipulation Language): Commands that manipulate data within tables.
o Examples: INSERT, UPDATE, DELETE, SELECT.

LAB ACTIVITY
Page-384

Do it yourself.

Maintain Healthy, Safe and Secure
Working Environment
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. Do it yourself.
2. « Do not use electrical appliances with wet hands to avoid electric shocks.

+ Always switch off and unplug appliances after use to prevent overheating and fire hazards.

8 Unsolved

Section A (Objective Type Questions)

A. 1. a 2. C 3. b. 4. d. 5. a. 6. b. 7. d.
8. ¢ 9. a. 10. c
B. 1. False 2. True 3. False 4. True 5. False 6. True 7. True 8. False
C. 1 c 2. a. 3. d 4. e 5 b.
D. 1. Physical Hazards 2. Emergency 3. Repetitive Strain Injury 4. Slips
5. Government 6. Well-being 7. Electrical 8. Assess

Section B (Subjective Type Questions)
A. 1. Managing Stress is very important for:
« Better Well-being: Managing stress can improve your overall well-being and health.

« Improved Productivity: When you're less stressed, you're likely to be more productive
and effective at work.
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2. Electrical accidents at work can be prevented by understanding and addressing common
causes which are follows:

+ Exposed, Worn-out Wiring: Old or damaged wires can cause electric shocks.

« Overloading Electrical Outlets: Plugging too many devices into one outlet can cause
overheating and shocks.

« Ungrounded or Faulty Equipment: Improperly grounded or broken equipment can be
dangerous.

« Unsafe use of Electrical Equipment: Using electrical tools or devices improperly can lead
to accidents.

3. « Eyestrain
« Repetitive strain injuries (RSI)
« Poor posture issues
« Exposure to electromagnetic radiation
4. It's important to find ways to manage and reduce stress at work:

« Conflict Resolution: Try to resolve conflicts calmly and respectfully with your colleagues.
Communication and compromise can often help.

« Taking Breaks: Take short breaks during the day to relax and recharge. This can help you
stay focused and reduce stress.

« Relaxation Activities: Find hobbies or activities outside of work that help you relax and
unwind. This can include exercise, reading, or spending time with friends and family.

5. Steps involved for Air and Water Quality Monitoring Process are:

1. Sample Collection: Samples are collected from areas surrounding the organisation where
pollution might occur.

2. Analysis of Samples: Perform physical tests to measure temperature and volume. Conduct
chemical tests to analyse gas content or pH levels. Use biological indicators to assess
ecosystem health.

1. When hazards are identified as significant risks in the workplace, it's crucial to implement
effective control measures to reduce or eliminate them. Here's how it can be done:

« Eliminate Hazards: The best approach is to eliminate the hazard if possible. This might
involve changing the process or using a safer alternative. For example, replace a
hazardous chemical with a safer one.

 Isolate Hazards: If eliminating them isn't feasible, isolate them from workers. This could
mean using engineering controls like noise insulation to reduce exposure. For example,
use barriers or shields to protect workers from machinery.

« Minimise Risks: If the hazard can’t be eliminated or isolated, minimise the risk it poses.
This involves using protective measures such as proper ventilation, Personal Protective

fiol
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Equipment (PPE), and monitoring exposure levels. For example, provide respirators for
workers exposed to harmful fumes and ensure they are trained in how to use them
correctly.

2. Several reasons can be specified for safety policy as given below:

It demonstrates the company’s dedication to ensuring the health and safety of its
employees.

It shows that business performance and safety standards are aligned.

It underscores that the company prioritises all stakeholders, not just profits.

It outlines accountability for workplace health, safety, and security for all employees.
The company adheres to India’s national Occupational Health and Safety (OH&S) policies.

The policy aims to prevent employee injuries and illnesses effectively.

3. Consider the following points for clean air:

Avoid Dust and Solid Particles: Minimise activities that produce dust and solid particles
in the air to reduce air pollution.

Limit Vehicle Use: Reduce the number of vehicles used on campus to lower emissions
that contribute to air pollution. Consider implementing a “no vehicle day” weekly.

Control Ozone Levels: Monitor and control ozone gas levels to prevent smog formation,
which can pollute the air.

Consider the following points for clean water:

Prevent Sewage Contamination: Ensure that sewage and wastewater from organisational
activities do not contaminate surrounding water sources.

Reduce Chemical Use: Avoid excessive use of fertilisers and pesticides, as they can pollute
groundwater and nearby water bodies.

4. Proper techniques for handling objects safely are crucial to prevent injuries and maintain a
safe working environment. Whether in an office, warehouse, or industrial setting, following
these guidelines can help reduce the risk of musculoskeletal injuries and other accidents:

Assessing the Object: Evaluate the object's size and shape to understand how to grip and
lift it safely.

Use Proper Techniques: Use a firm grip. Ensure your hands are dry and the object is free
of slippery substances. Keep your back straight and bend at your knees and hips, not
your waist. Lift the object slowly and steadily using your leg muscles, keeping the object
close to your body.

Get Help if Needed: If an object is too heavy or awkward to lift alone, ask for assistance
from a co-worker.

Use Equipment: Use trollies or carts to transport heavy or bulky items. In industrial settings,
use forklifts or pallet jacks for heavy loads. For very heavy objects, use hoists or cranes
operated by trained personnel.

Clear Pathways: Ensure pathways are clear of obstacles to avoid tripping while carrying
objects.

8.0
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By using above safety guidelines, you can reduce the risk of injury while handling objects in
the workplace.

5. Following these safety guidelines helps ensure a safer workplace environment. Here's what
each guideline means:

 Store chemicals safely in closed containers and separate cupboards.

+ Dispose of garbage daily to keep areas clean and pest-free.

« Ensure proper lighting to avoid accidents.

« Wear proper clothing; avoid loose clothes and jewellery near machines.
« Avoid distractions around fire, tools, and machinery.

« Use protective gear like gloves, goggles, or masks when needed.
 Turn off machines before leaving the workplace.

« Handle electricals carefully; don't play with switches or controls.

+ Get trained before using any machine or equipment.

« Check electricals; repair damaged wires or plugs before use.

« Inspect equipment; report anything that sparks, smokes, or seems unsafe.
« Cover food to keep it clean and uncontaminated.

« Follow no-smoking rules to prevent fire hazards.

« Report unsafe conditions to your supervisor immediately.

6. Electrical safety is crucial in preventing shocks, short circuits, and fire hazards. Here are some
essential safety rules to follow when using electrical equipment:

« Do Not Overload Circuits: Avoid plugging too many devices into a single outlet, as this
can lead to overheating and fires.

 Inspect Cords and Plugs: Regularly check wires for damage, fraying, or loose connections
before use.

« Use Dry Hands: Never operate electrical appliances with wet hands to prevent electric
shocks.

« Keep Water Away from Electrical Devices: Avoid placing electrical equipment near water
sources such as sinks and bathtubs.

« Turn Off Unused Equipment: Unplug appliances when not in use to save energy and
prevent overheating.

« Use Correct Voltage: Always use electrical devices according to their voltage requirements
to prevent short circuits.

+ Keep Children and Pets Away: Ensure electrical outlets and cords are out of reach of
children and pets.

+ Follow Manufacturer’s Instructions: Always read and adhere to the user manual for safe
handling.
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Install Circuit Breakers: Use surge protectors and circuit breakers to prevent electrical
overload and fire hazards.

Hire a Professional for Repairs: Avoid DIY repairs; consult a certified electrician for fixing
electrical issues.

By following these rules, both homes and workplaces can minimize electrical risks and ensure
safety for everyone.

C. 1. To ensure a safe and secure school environment, the following clubs can be formed:

Health & Wellness Club: Organizes health check-up camps, promotes mental health
awareness, and educates students about nutrition and hygiene.

Safety & Emergency Response Club: Trains students in first aid, conducts fire and
earthquake drills, and ensures emergency exits are accessible.

Cyber Safety Club: Educates students on internet safety, cyberbullying prevention, and
responsible use of technology.

Anti-Bullying Club: Works on spreading awareness about bullying, supports victims,
and encourages peer mediation.

Environmental Safety Club: Promotes waste management, cleanliness drives, and eco-
friendly practices in school.

Security Awareness Club: Focuses on student identification systems, ensures safety at
entry and exit points, and educates about emergency protocols.

These clubs will play a crucial role in creating a secure, healthy, and aware school community.

2. During the mock drill, the following hindrances were observed that could delay evacuation:

Lack of Awareness: Some students and staff were unaware of the evacuation routes and
procedures.

Blocked Exits: Certain emergency exits were obstructed by furniture or locked, making
evacuation difficult.

Panic and Confusion: Some students panicked, leading to unnecessary crowding and
slowing down the process.

Ineffective Communication: The alarm system was either not loud enough or unclear,
causing delays in response.

Slow Movement: Younger students and those unfamiliar with the drill took longer to
move, creating congestion in hallways.

Lack of Coordination: Teachers and staff were not fully prepared to guide students
efficiently.

Delayed Assembly: Some students failed to reach the designated safe zone on time.

Technical Failures: Faulty alarms or unresponsive emergency lighting made it difficult
to navigate corridors.

To improve future drills, regular training sessions, proper signage, and ensuring open
pathways should be emphasized.
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Previous Years' Questions

1. Two basic fire safety rules to be followed in any organization:
« Ensure Proper Fire Exits and Emergency Evacuation Plans

« Keep Fire Extinguishers Accessible and Maintain Them Regularly
2. First Aid.

8% video based question Page-420

Do it yourself.
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